Working With PC-PUMP v3

This document is intended for moderate to experienced PC-PUMP users. If you are new to PC-PUMP,
please consult the user guide contained within the software for detailed explanations on how to use the
software.

If you choose to read nothing else in this document, please take a moment to review the section on
equipment cases, as these are handled quite differently in v3.

Introduction

In an effort to modernize both the look and usability of PC-PUMP, we decided that it was time to update
the graphical user interface (GUI). This effort did not alter the calculations themselves or the results
generated — only how you interact with the software.

This effort enabled us to better integrate existing features that had been shoehorned into the original
GUI designed in 1995. With a more logical arrangement of inputs and features, the new version is
better prepared for future work and expansion.

In addition to the above, we made certain that the GUI in v3 could be translated into multiple languages
with relative ease. The initial release will be in English; however, other languages, such as Chinese, will
follow.

V3 can perform the same analyses as v2.x. In fact, with the new changes and increased flexibility of the
new interface, v3 can do more. This document outlines each of these changes and how to take
advantage of them so that you get more out of your analysis work.

What's Different from v2.x?

This list is a quick reference to the major changes that you should be aware of when using PC-PUMP v3 if
you are already somewhat familiar with v2.x. Please refer to the Help File or User Guide for more
details, if needed.

1. The user guide has been fully updated and properly imported into the software. In virtually every
window, there is a small blue circle with a white question mark in it. Clicking on this icon will take
you directly to the Help File page that is relevant to the window you are in. In addition, the
background technical information has been included with the descriptions of how to use the
window (in the v2.x User Guide it was a separate section).

The Project Information window has been moved from the Edit menu to the File menu.

The main inputs and outputs are divided into tabs arrayed across the top of the window. In
general, you will work from left to right across the tabs, although you can enter your inputs in any
order you wish.

4. The Kelly Bushing Offset has been moved to the Wellbore Geometry tab in v3 from the Equipment
Configuration window in v2.x.
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A new Options tab now contains calculation options, which were located in a couple of different
places in v2.x.

In v2.x, navigation through a series of results charts required selecting from a series of tabs
located at the bottom of the charts. In v3, navigation is now handled by a drop down list where
you can select which chart you wish to look at. Hint: Once you have clicked in the drop down list
you can use the up and down arrows on your keyboard, or by scrolling up or down on your mouse
to change the chart.

In v3, new graphing software was used to better display results. If you want to zoom in on a
chart, right click on one of the axes, select “Properties...” and then change the limits of the
selected axis.

In the Equipment Configuration window, there is only one place to click to enter the selection
window for each type of equipment. It is a small icon (of a window and pencil) located beside the
title of each type of equipment. As equipment is added, the wellbore diagram in the middle of
the window is updated to reflect the actual equipment selected.

PC-PUMP v3 takes advantage of the use of “right-clicking”. This is especially true in tables, where
right-clicking can be used to insert or delete rows (for example sections of casing or tubing), or to
clear all the equipment from a table (for example, to completely change the rod string).

The Rod String selection window inputs have been rearranged to improve clarity. In the previous
releases, there was a “Copy” button that simplified the process of changing the rod string by
allowing you to automatically fill in the selection drop down lists. In v3, to perform the same
action, you must right click on a rod in the table and select “Select above inputs using this rod”.
The Pump Selection window now has a listing for “All Companies”. There are over 2000 pumps in
the database, so this option by itself is a bit daunting, but it can be very useful when used with the
filtering option.

In the Operating Conditions tab, there is a new option for specifying temperature. The two
previously existing options are there, but a third option is now available: “Producing Fluid
Temperature Profile”. This allows you to specify the temperature along the wellbore in any way
that you like. In most cases, the linear options that existed before will be adequate, but in some
applications, the extra power of this new option may be useful (e.g. if a portion of the tubing was
installed with an electric heat trace).

After doing a calculation, all the main outputs are available in the “Analysis Results” tab. Within
this tab are several other tabs, which correspond to the Summary Outputs table and the charts
and tables that can be accessed through the buttons in the middle of the v2.x Analysis Outputs
window.

The Auxiliary Analyses tab contains the wear, fatigue, backspin, and sand-settling calculations.
The inputs in these are very much the same as they were in v2.x. In the wear and fatigue
windows, the results calculate automatically. If you change a number in one of the input boxes,
the results will recalculate if you move the cursor out of the box you just changed (by clicking
elsewhere or pressing the tab button on your keyboard). (Note, take care not to click the main
Calculate button at the bottom right of the main PC-PUMP window, instead.) In Backspin, you do
need to click the Calculate button within the backspin tab (again, not the main Calculate button).



Cases and Comparisons in PC-PUMP v3 as Compared to v2.x

The first thing that users need to be aware of is that cases in v3 have their own wellbore geometry, fluid

properties, operating conditions and analysis options. For example, changing the flow rate or viscosity

in one case does not change it in all cases, as it did in v2.x.

A summary of the other differences are as follows:
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Each case is fully independent and each has four sets of input data, corresponding to the inputs in
the first four tabs across the main window of PC-PUMP: Wellbore Geometry, Equipment
Configuration, Fluid Properties, and Operating Conditions. There is also a set of input data
corresponding to the inputs in the Options tab, but this is handled slightly differently, as will be
discussed below.

Each case shows up in the Case Manager on the right hand side of the main PC-PUMP window. If
you click on the “+” sign next to the case, the different input sets (other than Options) will appear,
in addition to Analysis Results. The Analysis Results will be blank until a calculation is done. The
Equipment Configuration has a “+” sign next to it, and clicking on this will show the subsets (e.g.
rods, tubing, pump, etc.)

You can drag and drop sets of input data (or subsets for equipment) from one case to another.
For example, if you have changed the operating conditions in one case and want to use the same
conditions in another case, you can drag and drop from one to the other. The program will ask
you if you want to overwrite the existing data. Likewise, you can copy the rod string, for example,
from one case to another without changing anything else.

When you click on the Calculate button, every case (with the exceptions noted below) will be
calculated. Essentially, the program always does a case comparison similar to the Equipment
Comparison feature in v2.x.

There are several menu items available by right clicking on a case name in the case manager:

a. Add Case: creates a new blank case;

b. Delete Case: deletes the selected case;

c. Copy Case: creates a new case that is a copy of the selected case ;

d. Rename Case;

e. Exclude from Calculation: turns off the case so that it will not be calculated when you click
on the Calculate button. This greys out the case icon. It can be re-enabled by right clicking
and selecting “Include in Calculation”; and

f. Show Messages: brings up a window containing the output messages for this calculation.
(These can also be viewed at the bottom of the Summary Tab in the Analysis Results.)

The icon beside each case indicates the status of the case, as follows:

a. Red circle with an “X”: The case contains errors which prevent it from being calculated.
This may simply because insufficient information has been entered, as you would have with
a new, blank case.

b. Yellow triangle with an “!1”: The case has not been calculated or the case has been
calculated but has a warning message.
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c. Green circle with “v"”: The case has been calculated successfully and results are available.
Once a calculation has been completed, the results tab will automatically be displayed for the
current case. You can view results for other active cases by clicking on those cases in the case
manager. If the calculation was not successfull for a case the Analysis Results tab will contain a
message saying the case has not been calculated.

If you have loaded a case that was created in v2.x (v2.5 or later), there will be at least two cases,
one surface and one downhole. For most users, the downhole case will be blank. The file
structure of v2.5-2.716 required that there be these two cases. PC-PUMP v3 no longer has this
requirement, so you are free to delete the blank case (either surface or downhole) using the Case
Manager.

After doing a calculation you can view the Analysis Comparison table by clicking on the button
below the Case Manager. Some notes to keep in mind include:

a. There are three tabs in the Analysis Comparison window. The first is the table itself. A new
feature in v3 is that you can click on a column heading to sort based on the values in that
column (click again to sort in the opposite direction). A small arrow appears to indicate the
sort direction.

b. The second tab is the Chart. This applies to batch analysis, which will be discussed below.

c. The third tab is Options. This allows you to choose which columns are displayed, and to
change the order they are displayed in. If you click the button that says “Remove
Inapplicable Columns”, it will remove any columns that have no valid data in them, or
which contain only zeros. Note that if you recalculate, and the results change, you will
need to click on this again to update it.

PC-PUMP v3 has a Batch Analysis that is very similar to the Batch Comparison in v2.x. To use it,
select the check box then click on the pencil/window icon beside the parameter box. All possible
batch parameters are listed there. Unlike v2.x, v3 will show you parameters which may not be
relevant to your calculations. (For example, GOR in a single-phase calculation or diluents rate
when you haven’t specified diluents injection.) If you pick an irrelevant parameter, it will still run,
but all the results will be the same. Values for the parameters are specified in the same way as in
v2.x. Click the OK button to close the window. The results will not be available until you also click
on the main Calculate button. When you do this, it will run the Batch Analysis on all the cases you
have in the case manager (except any which you have specifically excluded). Note that this can
result in a large number of calculations being performed. Some comments on viewing the results:

a. Ifyou click on the arrows below the batch parameter (or move the slider), it will update the
cases shown which match that parameter value. You can then look at any of the input or
output windows, for any case at that parameter value.

b. If you click on the Show Analysis Comparison Table button, the Analysis Comparison
window will open.

c.  When a Batch Analysis has been done, there is an option called “Current View” in the lower
left corner of the Table tab in the Analysis Comparison window. The first option, “Cases in
table for single batch parameter value”, shows each case as a row in the table, and you can
use the slider or arrows to select which batch parameter value they are shown for. The
second option, “Batch parameter values in table for single case”, shows the results for one



case (selected in a drop down box), and the table has rows for every batch parameter
value.

In the Chart tab, you will see charts similar to the Batch Comparison Charts in v2.x. The
main difference is that you will see the charts for all the cases, showing how the results in
each change with the batch parameter value. (If you see only one line in the graph, then
either you have only one case, or the different cases all give the same value for that output,
or one or more cases don’t have a valid value for that output.) You can select which output
you see graphed using the drop down at the top of the chart tab.



